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Introduction

Carefully read this instruction booklet, as it contains important advice for safe installation, operation and maintenance. 
Keep this booklet on hand in a safe place for future reference by other operators or users.

Stoddart design, manufacture & distribute Food Service Equipment (appliances) exclusively for the commercial market.
This appliance is not designed nor intended for household or domestic use & must not be used for this purpose.

This product is intended for commercial use, and in line with Australian electrical safety standards the following warnings are provided:

• This product is not intended for use by persons (including children) with reduced physical, sensory or mental capabilities, or lack of 
experience and knowledge, unless they have been given supervision or instruction concerning the use of the product by a person 
responsible for their safety.  Children should be supervised to ensure that they do not play with the product

• If the supply cord is damaged, it must be replaced by the manufacturer, its service agent or similarly qualifi ed persons in order to avoid 
a hazard

The manufacturer and distributor cannot be held responsible or liable for any injuries or damages of any kind occurred to persons, 
units or others, due to abuse and misuse of this unit in regards to installation, removal, operation, servicing or maintenance, or lack of 

conformity with the instructions indicated in this documentation.

Disclaimer

All units made by the manufacturer are delivered assembled, where possible, and ready to install.  Any installation, removal, servicing, 
maintenance and access or removal of any parts, panels or safety barriers that is not permitted, does not comply in accordance to this 

documentation, or not performed by a TRAINED AND AUTHORISED SPECIALIST will result in the
IMMEDIATE LOSS OF THE WARRANTY.

The manufacturer cannot be held responsible or liable for any unauthorized modifi cations or repairs.  All modifi cations or repairs must 
be approved by the manufacturer in writing before initiating.  All modifi cations or repairs performed to this unit must be performed at all 

times by a TRAINED AND AUTHORISED SPECIALIST.

Thank you for choosing this quality Woodson product.
All Woodson products are designed and manufactured to meet the needs of food service professionals.  By caring for and maintaining your 
new Woodson product in accordance with these instructions, will provide many years of reliable service.

Stoddart is a wholly Australian owned company, which manufactures and/or distributes a comprehensive range of food service equipment for
kitchens, food preparation and presentation.  Stoddart products are manufactured and/or engineered in Australia to provide excellent results 
whilst offering value-for-money, ease-of-use and reliability.

Your New Woodson Product
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• All units MUST be installed according to the procedures stated in the installation section of this manual
• In the case of new personnel, training is to be provided before operating the equipment
• DO NOT use this unit for any other purpose than its intended use
• DO NOT store explosive substances such as aerosol cans with a fl ammable propellant in or near this unit
• Keep fi ngers out of “pinch point” areas
• Unit is not waterproof DO NOT use jet sprays, hoses or pour water over/on the exterior of the unit
• Only use this unit with voltage specifi ed on the rating label
• Do NOT remove any cover panels that may be on the unit
• DO NOT use sharp objects to activate controls
• DO NOT use sharp objects to remove ice from the unit
• If any fault is detected, refer to troubleshooting
• The manufacturer declines any liability for damages to persons and/or things due to an improper/wrong and/or unreasonable use of the 

machine
• Only specifi cally trained/qualifi ed Technicians (Stoddart, one of our service agents, or a similarly qualifi ed persons) should carry out any 

and all repairs, maintenance and services

When using any electrical unit, safety precautions must always be observed.

Our units have been designed for high performance.  Therefore, the unit must be used exclusively for the purpose for which it has been designed.

General Precautions

Warranty Registration

Warranty Period

Australia and New Zealand Warranty

To register your new product, go to the Stoddart warranty page: http://www.stoddart.com.au/warranty-registration

Stoddart 12 month on-site parts and labour warranty (terms and conditions apply), from the time of purchase.
To view or download the warranty terms and conditions visit: http://www.stoddart.com.au/warranty-information 

Warranty & Registration
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WARNING
DO NOT cover or block the exhaust vents.

Doing so can cause a fire, property damage, injury or death.

NOTE: Please read the Software instructions Page 15-25 before using the USB

On/Off

HOT AIR
Exhaust Vent

Heat Deflector
Wall Spacer

Rating Plate

Wire Rack

Crumb Tray

Air Filter

Control Panel

Foot
USB Port

Catalytic Converter

Installation

Product Overview

CAUTION

Surface is HOT
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Installation

Setting Up

Handling

Unpacking

Positioning

Disposal

•	 Use suitable means to move the unit;  
- For smaller items use two people 
- For large items a fork lift, pallet trolley or similar (the forks should reach completely beneath the pallet)

•	 Check the unit for damage before and after unpacking.  If unit is damaged, contact the distributor and manufacturer
•	 Should any item have physical damage, report the details to the freight company and to the agent responsible for the dispatch within 

seven (7) days of receipt.  No claims will be accepted or processed after this period
•	 The unit is supplied fully assembled
•	 Remove all protective plastic film, tapes, ties and packers before installing and operating
•	 Clean off any remaining residue from the interior/exterior of the unit using a clean cloth dampened with warm soapy water

•	 Choose an area that is well ventilated and provides access for future maintenance
•	 Place the unit on a level stable work surface capable of supporting its weight
•	 Do not position the unit in: 

	 - Wet areas 
	 - Near heat and/or steam sources 
	 - Near flammable substances

•	 Allow an air gap between the unit and other objects or surfaces.  A minimum gap of 100mm from all sides is recommend for normal 
operational use (if the unit is near any heat sensitive material we suggest you allow additional space)

•	 Please consult national and local standards to ensure that your unit is positioned in accordance with any existing requirement

WARNING
Improper installation, adjustments, alterations, service or 
maintenance can cause property damage, injury or death.

100mm

APPLIANCE

10
0m

m

10
0m

m

Front

•	 At the end of the appliance’s working life, make sure it is scrapped & components recycled properly
•	 Current environmental protection laws in the state/country of use must be observed
•	 Doors must be removed before disposal (if applicable)
•	 Power supply cable must be removed before disposal
•	 For further information on the recycling of this product, contact the local dealer/agent or the local body responsible for waste disposal
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Installation

Electrical Connection

This unit must be installed in accordance with AS/NZS 60335.1

Some procedures in this manual require the power to the equipment to be turned off and 
isolated.  Turn the power OFF at the power point and unplug the power supply lead by the plug 
body.  If the power point is not readily accessible turn the equipment off at the isolation switch 
or the circuit breaker in the switchboard.  Attach a yellow “CAUTION-DO NOT OPERATE” tag. 

This must be performed where relevant unless the procedures specify otherwise.
FAILURE TO DO SO MAY RESULT IN ELECTRIC SHOCK.

WARNING

Single Phase Units:
•	 Supplied and fitted with an appropriately rated plug and lead, indicated as: 

- 32A plug & lead fitted

Notes:
•	 If the supply cord is damaged, it must be replaced by the manufacturer, its service agent or similarly qualified persons in order to avoid a 

hazard.  Please contact Stoddart for parts and we will advise how to do this in order to avoid any electrical hazard
•	 The power cable should be dry and/or isolated from moisture or water
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Quick Installation

Tilt the oven, and secure the four feet to the
underside of the oven.

pronto

Open the oven door and remove all
documents, accessories, packing materials
and protective plastic film. 

Attatch the wall spacer brackets provided, 
using the thumb screws provided.

1. 3.2.

Place Oven on the working surface, keeping a recommend gap of 55mm between the back of the oven and the wall and a 55mm gap 
from the sides of the oven and other appliances and or walls. Level by adjusting the feet.

pronto

55mm55mm 55mm4.

Connect to an appropriately rated and 
earthed power supply (see Page 6). 
Switch on.

Enjoy cooking with your new 
Woodson Pronto Oven! 

pronto 6.5.

CAUTION!
DO NOT leave the hot air exhausts exposed, contact with hot air 

exhaust can cause burns and serious injury.

Installation
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Specifications
Model W.PO52
Height 613mm 
Width 520mm
Depth 714mm (689mm without 

spacer) 
Net Weight 56.5kg
Operating Ambient 
Temperature

10°C - 40°C

Operating Ambient Humidity 20 - 60%
Power 5.28kW

714

180

320

843

594

87˚

62

520

613
550

Specification

Technical Specifications
W.PO52
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Operating Instructions

First Time Operation

Basic User Interface Functions

Upon setting up your equipment, the following steps must be followed:

1.	 Turn the unit on at the “Power Switch”. The oven will enter the warm up mode and display the warm up screen. 
This will take approximately 5-10 minutes for the oven to reach operating temperature

2.	  Once the warm up sequence has reached the standby temperature of 200°C, the oven is ready for use and will display the 
Basic User Interface, as shown below

Main Menu

Scroll Up

Scroll Down

Manual Cooking

Cookbook Menu

The oven is designed for easy use through a pre-programmed “cookbook” which can hold up to 50 cooking recipes. The oven comes pre-
loaded with a cookbook. 

To add or adjust cooking recipes users must do this on a PC using the MakeProfile software. This software is installed on the USB supplied 
with the oven and must be copied to the PC.

A saved “cookbook” is copied to the USB then transferred to the oven by inserting the USB into the oven and uploading the file.

Operation
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From the “Basic User interface” touch the Main Menu icon to enter the Main Menu:

EnglishEnglish

Simplified Chinese

Japanese

Korean

Traditional Chinese

Return: Return back to the Basic User interface

Software Upgrade: Update system to latest software

Language Selection: Choose from five different languages

Information: Serial number, software and hardware version

Temperature Display: Change temperature to Fahrenheit or Celsius

Cookbook: Upload a custom cookbook, this will overwrite the existing cookbook on the oven (pin required), refer to page 24

General Settings: Adjust Standby temperature, Power saving temperature, temperature correction, idle timer, change temperature 
display. (Note settings stored manually on the oven will be overwritten when a cookbook is uploaded to the oven).
- Enter the general settings PIN “9999” use the  tabs to change the number (0 - 9). Touch the  icon, this will bring up the 
general settings display. (The PIN “9999” cannot be changed)

Cleaning Assist: When this icon is touched, the device enters the cooling state. The device can be cleaned only after the cooling is 
completed, refer to page 27

A

A

B

B

C

D

E

C

A

B

CE

D

C/F
Enter PIN
9 9 9 9

A

B

C

D

Default Settings: Adjust Standby temperature, Power saving temperature, temperature correction, idle timerD

Operation
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180°C

200°C

30:00

25°C

0

Standby Temperature: Default temperature 200°C. Adjustable range 150°C ~ 250°C

Temperature Correction: Technician use only

Power-Saving Temperature: Default temperature 180°C. Adjustable range 100°C ~ 180°C

Temperature Zone: Default Zone:5°C ~ 30°C. This function is strongly recommended for high volume use. After setting the 
temperature zone, the device will start cooking without having to reach the set temperature (For example, if the set temperature is 200°C 
and the set temperature zone is 30°C, then the device will enter the cooking status when the device’s actual temperature reaches 
170°C ~ 230°C)

Idle Time: Default idle time 20minutes. Adjustable range 0 ~ 30minutes. Oven automatically enters power-saving mode after idle time. 
(When “0”is selected oven will not enter the energy saving mode)

A

E

B

D

C

A

B

C

D

E

Operation
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Programmed Menu Selection

•	 Turn the unit on at the “Power Switch”. (The Start up screen will display)
•	 Wait 5-10 minutes for the oven to reach the preset standby temperature (200°C default)
•	 When the oven reaches the standby temperature it will automatically enter the default Basic User interface
•	 Up to 50 cooking recipes can be stored in the cookbook menu, with 4 appearing on the display screen at one time
•	 Touch the  icons to scroll through the stored cookbook cooking recipes

1.	 Select a cooking recipe from the programmed cookbook selection ( e.g. “Chicken 
Mid-Wings Raw”). Touch the required icon, if required the Pronto oven will heat up 
or cool down depending on the selected product

6:00

2.	 When the device reaches the set cooking temperature, the display will show the 
“Load Product” screen

3.	 A signal will sound once the cooking program has finished, remove the food from 
the oven. (The screen automatically switches back to the default interface after the 
oven door is closed)

4.	 When cooking is in progress, The countdown timer will start as soon as the door is 
closed.

Load Product

Note: Cooking recipes are programmed on a PC using the software supplied with the oven. See pages 15-23 for instructions on how to 
program the cooking recipes and upload to the oven.

Cancel Operation

Cancel Operation

Operation
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Manual Cooking Selection

1 2
200°C

2:00

100%

0

1 2
200°C

2:00

100%

0

1 2
200°C

2:00

100%

0

Manual cooking can be programmed to operate with two stages. After Stage 1 has been entered, enter Stage 2 if required.

•	 Turn the unit on at the “Power Switch”. (The Start up screen will display)
•	 Wait 5-10 minutes for the oven to reach the preset standby temperature (200°C default)
•	 When the oven reaches the standby temperature it will automatically enter the default preset menu interface

1.	 Touch the Manual Cooking icon.

2.	 Cooking Temperature: 
Touch the temperature icon or the number, and use the  tabs to adjust 
the parameter value. (100°C - 275°C)

3.	 Cooking Time: 
Touch the time icon or the number, and use the  tabs to adjust the 
parameter value. (10secs - 10mins)

4.	 Fan Speed: 
Touch the fan icon or the number, and use the  tabs to adjust the 
parameter value. (50% - 100%)

Operation
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1:15

Load Product

1 2
200°C

2:00

100%

0

1 2
200°C

2:00

100%

0

5.	 Bottom Infrared Element: 
Touch the heating pipe icon or the number, and use the  tabs to adjust 
the parameter value. 
Level 0: 800W (default) 
Level 1: 1500W 
Level 2: 2000W 
Level 3: 2500W 
Level 4: 3000W

6.	 After completing the settings, touch the  icon

7.	 When the device reaches the set cooking temperature, the display shows the 
words “Load Product”

8.	 When cooking is in progress, The countdown timer will start as soon as the door 
is closed

9.	 A signal will sound once the cooking program has finished, remove the food 
from the oven. (The screen automatically switches back to the default interface 
after the oven door is closed)

Cancel Operation

Cancel Operation

Operation
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Software Instructions (PC)

Use the MakeProfile software to program your cookbook with up to 50 cooking recipes.

Note: Some computers may or may not show file extensions. e.g. file.bin / file.pdf / file.exe (this user manual shows file extensions).

New

Open

Save

Save as

Exit

Menu connect versionIcons library

Cookbook version

File HelpEdit

File name: *.bin

Cancel

DATA (D:)

OS (C:)

USB (F:)

recipe01
Open

Recipe Cookbooks

Recipe Icons

Default Cookbook

Software

User Manuals

Default Cookbook
recipe01.bin
recipe02.bin

USB

default.bin

Recipe Cookbooks

Default Cookbook User Created 
Cookbooks

profile.binRecipe Icons

Text Template Generic Icons

Text Icon Template.doc

Software

MakeProfile.exe

User Manual

User Manual.pdf

Recipe Guide.pdf
Warranty.pdf

Recipe Cookbook Creation/Alteration

1.	 Insert the supplied USB into your PC. USB file structure shown below.

2.	 Save a backup copy of all the files on the USB to the PC. ( We suggest this to be done regularly as the recipe library is increased)

3.	 Open the Software folder on the USB, then launch the “MakeProfile”software (right click MakeProfile.exe then select Open). When 
MakeProfile opens to the home screen you will see 3 drop down menus in the “menu bar” File, Edit and Help. 
Note: If MakeProfile does not launch refer to troubleshooting on page 30

4.	 New Cookbook: To create a new cookbook from the menu bar select: File > New. 
Existing Cookbook: To edit an existing cookbook from the menu bar select: File > Open > USB > Recipe Cookbooks

Operation
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Cooking Recipe: When creating a new cookbook, 3 default cooking recipes are shown with 1, 2 and 3 as the default cooking recipe 
icons, these cooking recipes can be edited/deleted. Create up to a total of 50 new cooking recipes on the cookbook.
(4 cooking recipes will be displayed at one time on the oven interface)

Scroll up: Use this to scroll up through the cooking recipes in the cookbook

Scroll Down: Use this to scroll down through the cooking recipes in the cookbook

Oven Configuration: Adjust the temperature display (Fahrenheit or Celsius), temperature settings, Idle Settings (standby temperature, 
power saving temperature, idle timer and temperature zone) and cookbook PIN

Print Cookbook: A cookbook with full program parameters for each recipe can be printed as a digital or hard copy (this is helpful for 
users to test recipe programs and make notes for modifications to be made in the cooking recipes using the software)

Delete Cooking Recipe: Select the desired "cooking recipe" icon, then click the “delete cooking recipe” tab. This will permanently 
remove a cooking recipe from the cookbook

New Cooking Recipe: Click the "new cooking recipe" icon, to create a new cooking recipe. Cooking recipes can be programmed to 
operate with two stages

Edit Cooking Recipe: Select the desired "cooking recipe" icon, then click the "edit cooking recipe" tab. Cooking recipes can be 
programmed to operate with two stages

Move Cooking Recipe Forward: Select the desired "cooking recipe" icon, then click the "move cooking recipe forward" tab to 
move the cooking recipe forward in the cooking recipe index (1-50). This will change the index numbers of the cooking recipes

Move Cooking Recipe Backward: Select the desired "cooking recipe" icon, then click the "move cooking recipe backward" tab 
to move the cooking recipe backwards in the cooking recipe index (1-50). This will change the index numbers of the cooking recipes

A

C

C

D

D

Cooking Recipe Index: Each recipe is allocated its own individual index number (1-50). This indicates the recipe sequence in the 
cookbook, this sequence can be adjusted using buttons C and D

B

E

E

F

F

G

G

H

H

I

I

J

J

K

K

A B

5.	 Recipe interface: It is the same process for editing an existing cookbook as it is for creating a new cookbook.

Operation



Page 18

Due to continuous product research and development,
the information contained herein is subject to change without notice.

www.stoddart.com.au
www.stoddart.co.nz

Cooking Recipe Icon: Displays the selected cooking recipe icon. This can be changed by clicking the “Icon Library”tab

Cooking Recipe Index: Indicates cooking recipe sequence in the cook book. This can be changed in the “recipes interface”

Cooking Recipe Stage: Each cooking recipe can be programmed to operate with 2 stages. Toggle between the 2 stages and enter 
each cooking recipe parameter D-G

1

A

A

B

B

C

C

D

E

F

G

H

K

I

J

Cooking Temperature: Click the “cooking temperature” value. Use the  tabs to adjust the parameter value. 
(100°C - 275°C)

Cooking Time: Click the “cooking time” parameter value. Use the  tabs to adjust the parameter value. 
(10secs - 10mins)

Fan Speed: Click the “fan speed” parameter value. Use the  tabs to adjust the parameter value. (50% - 100%)

Icon Library: Click the “icon library” tab to change the cooking recipe icon. Custom icons can be imported from your PC

Parameter Value Up: Increase the value of the selected parameter

Parameter Value Down: Decrease the value of the selected parameter

Save: After completing cooking recipe, click the  tab save and exit from the Parameters Interface

Bottom Infrared Element: Click the “bottom infrared element” parameter value. Use the  tabs to adjust the parameter 
value. (Level 0: 800W (default), Level 1: 1500W, Level 2: 2000W, Level 3: 2500W, Level 4: 3000W)

D

E

F

G

H

Return: Clicking the “return” tab will exit out of the Parameters interface without savingK

I

J

L

L

6.	 Recipe Programming Parameters interface: To enter the Parameter Interface click on the “edit cooking recipe” or “new cooking recipe” 
tab in the Recipe Interface. Here you can enter/adjust the parameter values for the selected 2 stage cooking recipe and change the 
cooking recipe icon

Operation
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Scroll up: Use this to scroll up through the cooking recipes icons in the Icon Library

Scroll Down: Use this to scroll down through the cooking recipes icons in the Icon Library

Cooking Recipe Icon: Embedded recipe icons available for use in your cookbook

Embed Recipe Icon: Click the “embed recipe icon” tab, navigate to saved images on your PC, select the image to embed then click 
open. When embedding a recipe icon, it needs to be a square shaped (e.g. 30 x 30mm) low resolution .jpeg, .png or .bmp file.
Custom Image files can be created by using the snipping tool to capture images of text or food items then saving as a .jpeg file.
Text images can easily be created to the required shape, using the Text Icon Template on the supplied USB

1

A

B

B

C

C

D

D

Delete Cooking Recipe Icon: Select the desired "cooking recipe icon”, then click the “delete cooking recipe icon” tab. This will 
permanently remove a cooking recipe icon from the icon library

E

E

Save: After selecting the desired “cooking recipe icon”, click the  tab save and exit from the Icon LibraryF

F

A

7.	 Icon Library: Recipe icons can be changed to suit a users preference. Icons can be created from any digital image on the users PC. To 
enter the icon library click on the “icon library” tab in the Parameters Interface. All icons uploaded to the cookbook are permanently 
embedded into the cookbook file

Operation
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Cookbook PIN: Change the PIN code for the cookbook from the default “0000”. Ensure new PIN code is recorded. 
(PIN code cannot be reset if forgotten)

New Pin: Enter the New PIN. Use the  tabs to change the number (0 - 9)

Return: Return back to the Recipe Interface

Confirm Pin: Confirm the New PIN. Use the  tabs to change the number (0 - 9)

Default Settings: Adjust Standby temperature, Power saving temperature, temperature correction, idle timer

Current Pin: Enter the Current PIN. Use the  tabs to change the number (0 - 9)

Temperature Display: Change temperature to Fahrenheit or Celsius

A

A

B

B

C

C

A

B

C

D

A

B

C

D

8.	 Oven Configuration: To enter the Oven Configuration click on the “oven configuration” tab in the Recipe Interface

9.	 Change Cookbook PIN: To change the cookbook PIN click on the “PIN” tab in the Oven Configuration

Operation
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Power-Saving Temperature: Click the “power-saving temperature” value. Use the  tabs to adjust the parameter value. 
(100°C - 180°C). The default temperature is 150°C

Idle Time: Click the “idle time” value. Use the  tabs to adjust the parameter value. (0 - 30 minutes). The default idle time is 20 
minutes. Oven automatically enters power-saving mode after idle time. (When “0”is selected oven will not enter the energy saving mode)

Temperature zone: Click the “temperature” value. Use the  tabs to adjust the parameter value. (5°C - 30°C). The default 
temperature zone is 25°C. This function is strongly recommended for high volume use. After setting the temperature zone, the device will 
start cooking without having to reach the set temperature (For example, if the set temperature is 200°C and the set temperature zone is 
30°C, then the device will enter the cooking status when the device’s actual temperature reaches 
(170°C - 230°C)

Standby Temperature: Click the “standby temperature” value. Use the  tabs to adjust the parameter value. (200°C - 
250°C). The default temperature is 200°C

Parameter Value Up: Increase the value of the selected parameter

Parameter Value Down: Decrease the value of the selected parameter

Save: After completing cooking recipe, click the  tab save and exit from the Parameters Interface

A

B

C

D

Return: Clicking the “return” tab will exit out of the Parameters interface. Any changes made will not be savedG

E

F

H

A

B

C

D

G

E

F

H

10.	 Change Default Settings: To change the default settings click on the “default settings” tab in the Oven Configuration.  
Note: This will overwrite any existing manual settings on the oven every time a USB upload is done

Operation
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Please input cookbook
version description

HelpEditFile

Icons library

Cookbook version

HelpEditFile

Save as

Open

Save

Exit

New

File name:

Save as type: *.bin

Cancel

DATA (D:)

OS (C:)

USB (F:)

cafem001

Save

Recipe Cookbooks

Recipe Icons

Default Cookbook

Software

User Manuals

recipe01.bin
recipe02.bin

11.	 Click Edit/Cookbook Version: To change the cookbook description select; Edit > Cookbook version from the menu bar. Enter a maximum 
of 8 characters (numbers, letters, symbols), to describe the cookbook version. e.g. “CAFEM001”.  
Note: It is recommended to make the description and the file name the same

12.	 Save Existing Cookbook: To save an existing cookbook select; File > Save from the menu bar

13.	 Save New Cookbook: To Save a new cookbook from the menu bar select; File > USB > Recipe Cookbooks, enter the same name as the 
cookbook version “cafem001” then click save

Operation
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To be able to upload a cookbook to the oven the cookbook file name must be re-named to “profile.bin” if this is not done an error will occur 
when trying to upload your cookbook.

1.	 To prepare a cookbook to be uploaded to the oven, open; USB > right click on the “profile.bin” file and select Delete from the right-
click menu

2.	 From the USB open the Recipe Cookbooks folder, right click the desired user created cookbook, select copy from the right-click menu

DATA (D:)

OS (C:)

USB (F:)

Recipe Cookbooks

Recipe Icons

Default Cookbook

Software

User Manuals

Default Cookbook

recipe01.bin

cafem001.bin

recipe02.bin

Open With

Scan with Windows Defender...

Scan for Viruses...

Send to

Cut

Create shortcut

Delete

Rename

Properties

Copy

DATA (D:)

OS (C:)

USB (F:)

Recipe Cookbooks

Recipe Icons

Software

User Manuals

Recipe Cookbooks

Recipe Icons

Software

User Manuals

profile.bin

Open With

Scan with Windows Defender...

Scan for Viruses...

Send to

Cut

Create shortcut

Rename

Properties

Copy

Delete

Prepare Cookbook For Uploading to Oven
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3.	 Go back to the USB main folder. Right click on a blank space of the USB window and select paste from the right-click menu

4.	 Right click on the user created cookbook “cafem001.bin”, select Rename from the right-click menu, rename the cookbook to 
“profile”. (Do not rename the file extension “.bin” If the file extension is shown)

DATA (D:)

OS (C:)

USB (F:)

Recipe Cookbooks

Recipe Icons

Software

User Manuals

Recipe Cookbooks

Recipe Icons

Software

User Manuals

Open With

Scan with Windows Defender...

Scan for Viruses...

Send to

Cut

Create shortcut

Rename

Properties

Copy

Delete

cafem001.bin

DATA (D:)

OS (C:)

USB (F:)

Recipe Cookbooks

Recipe Icons

Software

User Manuals

Recipe Cookbooks

Recipe Icons

Software

User Manuals

View

Sort by

Group by

Refresh

Paste shortcut

Paste

Share with

New

Properties

Customise this folder...

Undo Rename Ctrl+Z

DATA (D:)

OS (C:)

USB (F:)

Recipe Cookbooks

Recipe Icons

Software

User Manuals

Recipe Cookbooks

Recipe Icons

Software

User Manuals

profile.bin
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•	 Turn the unit on at the “Power Switch”. (The Start up screen will display)
•	 Wait 5-10 minutes for the oven to reach the preset standby temperature of 200°C
•	 When the oven reaches the standby temperature of 200°C it will automatically enter the default preset menu interface

Insert USB

Enter PIN
0 0 0 0

1.	 Touch the Main Menu icon

2.	 Touch the Cookbook icon

3.	 Enter the cookbook password. (The default PIN is “0000”). 
Note: The cookbook password is different to the general settings password

4.	 Remove the “USB Port Cover” from the right hand side of the oven and insert 
the USB

Upload to Oven

Operation
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Uploading

Upload �le
Completed

5.	 The cookbook will automatically upload to the oven

6.	 A signal will sound when the cookbook has uploaded to the oven

7.	 The new cookbook profile will now be displayed on oven interface. 
Remove the USB and re-insert the “USB Port Cover”

Operation
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Cleaning

Materials Required:

•	 Kay QSR Oven Cleaner (Order form on Page 36)
•	 Kay QSR Soil Shield (Order form on Page 36)
•	 Non-Abrasive Sponge
•	 Clean Sanitised Cloth
•	 Container of warm water
•	 Appropriate PPE (Personal Protective Equipment)

General Information
•	 Do NOT use abrasive pads or cleaners on any parts of the unit
•	 Do NOT use industrial chemical cleaners or caustic based cleaners, many will damage the metals and plastics used on this unit. Only 

use the cleaners specified below
•	 When drying, metal surfaces should be wiped with a soft cloth in the same direction as grained polish
•	 This unit is NOT waterproof, do NOT hose, do NOT pour water directly onto the unit

Cleaning Schedule
•	 Daily cleaning is required for the oven cavity, door, air filter and external surfaces. This will help to maintain and prolong the efficiency of 

your oven
•	 The Catalytic Converter should be replaced approximately every 6 months or when required depending on use (e.g. odors become 

noticeable)

WARNING
This unit is NOT waterproof, do NOT hose.
DO NOT pour water directly onto the unit.

WARNING
Wait until the unit has cooled to a safe temperature before 

undertaking any cleaning or maintenance. This can be 
ensured by entering the ovens Cleaning Assist mode.

Contact with hot surfaces can cause burns and serious injury.

Cleaning and Maintenance
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Cleaning Assist

Wait ...

Start Cleaning

When �nished

The oven must be completely cooled down to a safe temperature before commencing any cleaning.
When in cleaning mode the oven will take approximately 30mins ± 10mins from 200°C.

1.	 Touch the Main Menu icon

2.	 Touch the Cleaning Assist icon

3.	 Open the oven door, to allow the oven to cool down. (This will take approximately 
30mins ± 10mins from 200°C)

4.	 Touch the Main Menu icon. A signal will sound once the oven has cooled down, and 
display a screen saying “start cleaning”.  
Disconnect/isolate the oven from power supply 
 
(If there is need of the oven to be heated back up to operating temperature, without 
cleaning the unit, touch the  icon and this will enter the startup mode)

Cancel Operation

Cleaning and Maintenance
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Oven Cavity Cleaning Procedure

1.	 Select the cleaning mode
2.	 Ensure that the oven has cooled down completely and power switch is off before any cleaning
3.	 Disconnect/isolate the oven from power supply
4.	 Remove the wire rack, crumb tray and any other loose accessories from the oven cavity
5.	 Remove the top jet plate by unscrewing the 3 top jet plate screws (do not discard/misplace screws)

6.	 Use a clean cloth dampened with warm water to remove food debris from the oven
7.	 Carefully spray the cleaner Kay QSR Oven Cleaner onto a non-abrasive sponge and apply to the interior surfaces of the oven. 

Allow the Kay QSR Oven Cleaner to sit for 5-10 minutes with the oven door open
8.	 Wipe clean using a cloth dampened with warm water, until all oven cleaner and soil has been removed. Ensure that all cleaner residue 

has been removed
9.	 The wire rack, crumb tray, top jet plate and all other loose accessories can be washed/cleaned separately in a dishwasher or sink
10.	 Ensure all items are completely dry before reinstalling

Oven Exterior Cleaning Procedure

1.	 Thoroughly wipe the exterior of the oven with a cloth dampened with clean warm water. Do not pour water directly onto the unit
2.	 Using a dry clean sanitised cloth, thoroughly wipe the oven dry

Using Oven Protective Agent

1.	 Shake “Pronto Soil Shield” well before use
2.	 Carefully spray the oven protector Kay QSR Soil Shield onto a non-abrasive sponge and apply lightly to the interior surfaces of the oven.
3.	 Close the oven door
4.	 Turn the oven ON and heat to 200°C for 10-15 minutes for Kay Soil Shield to dry (Note: Kay Soil Shield turns a hazy white colour when 

dry, and is left on the oven surfaces until the next cleaning cycle)

Using the protective agent Kay QSR Soil Shield will make the oven easier to clean. Only use the oven protective agent after the oven has been 
completely cleaned and dried.
Do not use on food contact surfaces.
Do not spray on the heating elements.

Top Jet Plate Screws

Cleaning and Maintenance
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Air Filter Cleaning Procedure
1.	 Remove the air filter from the front of the oven
2.	 Use a vacuum cleaner to remove dust from the filter, or rinse with water
3.	 When filter is very dirty, soak it in warm soapy water, then rinse with clean water and dry before re-installing. A dirty filter will affect the 

operation of this device
4.	 For air filter replacement, see order form on Page 36

Catalytic Converter Maintenance Procedure
Stoddart recommend replacing the Catalytic Converter every 6 months or when required depending on use (e.g. odors become noticeable)

1.	 Select the cleaning mode
2.	 Ensure that the oven has cooled down completely and power switch is off before any maintenance
3.	 Remove the wire rack, rack support, crumb tray and any other loose accessories from the oven cavity
4.	 Remove the top jet plate by unscrewing the 3 top jet plate screws (do not discard/misplace screws)
5.	 Remove the two butterfly nuts (no tool required) on the left and right side of the Catalytic Converter, then remove the Catalytic Converter
6.	 For Catalytic Converter replacement, see order form on Page 36

Butterfly ScrewCatalytic Converter

Cleaning and Maintenance
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Troubleshooting

Problem Troubleshooting/Cause

The device does not run or the 
display does not work

•	 Is the power cord loose/connected/switched on 
•	 Has the circuit breaker tripped or the fuse blown?
•	 Is the unit installed in accordance with this user manual?

The display shows a warning 
message

•	 Operate the device according to the warning message

The device does not properly 
cook food

•	 Is the device clean?
•	 Has the oven reached the correct temperature?
•	 Wrong Cookbook recipe selected?
•	 Was the food packaged or unpackaged?
•	 Was the food removed before cooking time has finished?

The device does not work to 
finish cooking

•	 A warning message displays. Operate the oven according to the Error code displayed, see Page 31 
•	 The oven door is open
•	 The oven overheats

An error code displays •	 If the oven malfunctions, please contact the Stoddart Service Department. Have the error code noted

Recipe cookbook wont upload •	 Plug USB into PC and ensure file is called “profile” and has not been placed in a sub-folder

MakeProfile.exe wont launch

1.	 Right click the Windows Taskbar and select Task Manager
2.	 Left click More Details
3.	 Scroll down the Processes until you see MakeProfile, right click MakeProfile then select End Task from 

the menu. Do this for any instances of MakeProfile
4.	 Close Task Manager. Re-Launch MakeProfile software from the USB (Right click, open)

Before contacting the Stoddart Service Department, please refer to the following troubleshooting checklist

1. 2. 3.

WARNING
Technician tasks are only to be completed by qualified service 

people. Check faults before calling service technician.

Cleaning and Maintenance
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Error Codes

Error codes are displayed on the oven interface. They are displayed to protect the oven and assist in fault diagnosis. 
When a error code is displayed, the oven’s automatic response will try to rectify the error. If the error persists:

1.	 Record the error code
2.	 Disconnect/isolate the oven from power supply
3.	 Contact the Stoddart Service Department

Error 
Code

Description Trigger Possible cause Automatic Oven Response
Error 
Level

D1
Door open too 
long.

The oven door is kept open for 
60s in preheating/cooking/idle 
mode.

1. Oven door left open.
2. Failed micro switch.

Error code displays, speaker sounds. Warning

M1
Abnormal motor 
current.

The motor current detected by 
power board is > upper limit.

1. Hot air leak to motor.
2. Motor failure.

Motor and heating elements power off, 
error code displays, speaker sounds 
until back to normal.

Critical

H1
Preheating 
process too long.

The warm up process takes 
more than 10 minutes for the 
oven cavity to reach 150°C.

1. Heater failure.
2. Motor failure.
3. Thermocouple error.

Motor and heating elements power off, 
error code displays, speaker sounds 
until back to normal.

Critical

H2
Cavity 
temperature too 
high.

The system detects oven 
cavity temperature > 315°C 
for 15 seconds.

1. Faulty IR control.
2. Cavity fire.

Heating elements power off, motor 
runs at max speed, error code 
displays, speaker sounds until back to 
normal.

Critical

H3
Ambient over 
heat.

The ambient temperature 
measured on control board or 
power board is >70°C.

1. Cooling fan fails.
2. Inlet air too hot.
3. Inlet air filter blocked.

Motor and heating elements power off, 
error code displays, speaker sounds 
until back to normal.

Critical

S1
Cavity sensor 
error.

Controller reading an 
open circuit across the 
thermocouple input.

1. Thermocouple not connected.
2. Thermocouple broken.
3. Failed control board.

Motor and heating elements power off, 
error code displays, speaker sounds 
until back to normal.

Critical

P1
Abnormal 
incoming power.

Power voltage is not within 
(200V-10%, 240V+10%) for 
30 seconds.

1. Power surge.
2. Power Shortage.

Motor and heaters power off, error 
code displays, speaker sounds.

Warning

C1
Communication 
error.

No communication can be 
made between power board 
and control board.

1. Problematic power board/
control board.

Motor and heating elements power off, 
error code displays, speaker sounds 
until back to normal.

Critical

--
Unable to operate 
the display 
screen.

No communication can be 
made between power board 
and control board.

Power board failure. The display shows a blank screen. Critical

Cleaning and Maintenance
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Name of Business

Name of Contact

Street Address

Suburb State Postcode

Phone Email

SDS sheets will be provided with each delivery.
KAY chemical used and recommended.

Code Description QTY.
Required

SPAR.WPO.F92867 Catalytic Convertor Set

SPAR.WPO.F92867 Air Inlet Filter

SPPO.AT.GK3201
Non-Stick 2/3GN Standard Aluminium Pan

(354 x 325 x 20mm)

SPPO.AT.GK1213
Non-stick 2/3GN Ribbed Non-Spill pan

(354 x 325 x 20mm)

CNCL.0098
Kay QSR Oven Cleaner

(946mL)

CNCL.0099
Kay QSR Oven Soil Shield 

(946mL)

Order form
Scan/Copy - Complete - Email to: spares@stoddart.com.au

or Contact 1300 307 289

Order Form

Order Form
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Service / Spare Parts
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Email: spares@stoddart.com.au
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New Zealand
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